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Introduction 
Thank you for choosing the Cewe digital programmable transducer, from here on described as 
Cewe DPT 
 
The Cewe DPT is a complete 3 phase programmable multifunction transducer in a 104 mm 
DIN rail mounting case. It provides very high accuracy in all measured quantities and can also 
provide measured instantaneous quantities on a bus system, for instance voltage, power, 
frequency. The Cewe DPT extensive configurable functional features together with the high 
accuracy enable application areas more numerous than for traditional transducers. Besides 
having well-designed traditional features such as current and voltage outputs it also 
communicates via two communication ports and can measure power quality quantities. 

About this user manual 
This user manual describes the Cewe DPT’s functions and provides the information needed to 
configure and use the transducer. The manual covers all versions of the dCewe DPT. Some of 
the described functional properties can be missing in certain transducer versions. The Cewe 
DPT is complemented with ConfigView, a PC program for configuring, manual reading and 
maintenance. The ConfigView is a part of the Cewe Instrument Management Console 
program. 

Contacting us 
For more information and technical support, please contact Cewe Instrument. 
 
Internet www.ceweinstrument.se 
 
E-mail technical support support@ceweinstrument.se 
E-mail order and product information marknad@ceweinstrument.se 
 
Telephone +46 (0)155 77500 
 
Address Cewe Instrument AB 
 Box 1006 
 SE-611 29 Nyköping 
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Product Description 
Connections 
Connections to the Cewe DPT are made on the meter terminal on the front of the transducer. 
The connections are: measuring voltages, measuring currents, analogue outputs, relay outputs, 
separate auxiliary power and connections to communication modules. 

 
Connections for Cewe DPT 
 
Analogue outputs 
Channel Design

ation 
Number - / + 

Ch 1 A1 21 - 
  22 + 
Ch 2 A2 23 - 
  24 + 
Ch 3 A3 25 - 
  26 + 
Ch 4 A4 27 - 
  28 + 

 
Digital outputs 
Ch 1 D1 40,41 
Ch 2 D2 42,43  

Connections 

    
IN OU

T 
U1 2  I1 1 3 
U2 5  I2 4 6 
U3 8  I3 7 9 
N 11     
      
Uaux1 13     
Uaux2 14     

Current, voltage and auxiliary power connections 
for Cewe DPT. 

RS-485 communication 
+  60 
GND  61 
-  62  
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Connector for Cewe DPT 

The screw terminals in the Cewe DPT are equipped with wire guards and can be used with 
cables up to 6 mm2.  

Auxiliary power 

The Cewe DPT is supplied with separate auxiliary power input. Auxiliary power can be 
supplied both with alternating current (AC) and polarity-independent direct current (DC) 
within a specified range and frequency. The power supply covers the whole range in the same 
variant. 

Digital outputs 

The Cewe DPT digital outputs are solid-state MOS-FET bipolar semiconductor relays, with 
normally open contact function. Internal current limit protects the relay from being damaged 
by excessively high current. They are galvanically isolated from all other terminals. 

Analogue outputs 

The Cewe DPT analogue outputs can either be hardware configured as bi-polar directional 
current or voltage outputs. They are open- or short-circuit protected and galvanic isolated 
from all other terminals. 

Communication ports (RS485 and USB) 

The Cewe DPT is equipped with two serial communication ports, USB and RS485. It is 
possible to use both ports simultaneously. 
 

• The USB point-to point connection is used for both configuration and reading of the 
Cewe DPT through a standard USB Mini-B connector. Modbus RTU is used as 
protocol. 

• The RS485 multi-drop connection is used for both configuration and reading of the 
Cewe DPT through three screw terminals used for shielded twisted-pair wires. 
Modbus RTU is used as protocol. 
It is possible to block the configuration option over RS485 and only allow reading. 
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Mechanical design 
The Cewe DPT can be mounted on any DIN-rail top hat rail system in any direction, 
according to DIN EN 50022. 
Dimensions (WxHxD): 104 x 71 x 114 mm 

Enclosure and protective earth 

The enclosure consists of a transducer base and a cover. The transducer is not connected to 
protective earth. 

Isolation and personal safety 

The current inputs are galvanically isolated from each other and to any other internal or 
external potential. 
The voltage input group is galvanically isolated to any other internal or external potential. 
The analogue and digital outputs and COM-ports are isolated from each other and to any 
other internal or external potential. 



Product Description 
 

8  

Measuring principles 
The measuring circuit in Cewe DPT consists of current and voltage transformers that provide 
signals to six parallel AD converters (analogue to digital converters) that are synchronised by 
a common clock signal. The digital signals are thereafter processed by a DSP. Using voltage 
transformers makes the electronics in the meter galvanically isolated from the measurement 
voltage, which provides good personal safety and protection for connected equipment, such as 
analogue outputs and communication equipment. 

Calculation flow 

All values are calculated in the Cewe DPT based on calibrated current and voltage values. 
Current and voltage amplitudes and phase angles are fully compensated in regards to 
accuracy, harmonics, frequency and temperature at all times. Based on these individually 
compensated current and voltage signals, all quantities that the Cewe DPT can present, are 
subsequently calculated. This means that accuracy for instant values is excellent and that 
active and reactive power are correctly calculated, including harmonic power.  

3-element transducer 

On the 3-element Cewe DPT, the phase voltages and neutral wires are connected to the 
transducer. The voltages measured are phase voltages. Power is calculated from three phase 
voltages and three currents. Harmonic measurement is made on phase voltages. The phase to 
phase voltage is calculated from the phase voltages. The different possible connection ways 
(No 1 and 2) can be seen in Appendix B – Network System Connection Diagrams (pg. 47). 

2-element transducer 

On the 2-element Cewe DPT, the neutral conductor is not connected to the transducer. The 
voltages measured are subsequently phase to phase voltages. Power is calculated based on 
two phase to phase voltages (U12 and U31) and two currents (I1 and I3) according to the 2-
watt meter method. The 2-element meter is primarily used for D-connected systems (3-wire). 
Harmonic measurement is made on phase to phase voltages. The different possible connection 
ways (No 3 to 7) can be seen in Appendix B – Network System Connection Diagrams (pg. 
47). 

1-element transducer 

On the 1-element Cewe DPT, the single phase voltage and neutral wires are connected to the 
transducer. The voltage measured is phase voltages. Power is calculated from the single phase 
voltage and current. Harmonic measurement is made on phase voltage. The phase to phase 
voltage is calculated from the phase voltage. The different possible connection ways (No 8) 
can be seen in Appendix B – Network System Connection Diagrams (pg. 47). 
 
A transducer that is bought with a certain element configuration can be changed to any other 
element configuration by the user. 
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Block diagram 
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Configuration, reading and maintenance 
ConfigView is a PC program that makes all Cewe DPT functions available. With 
ConfigView, you can do: 
 

• Configuration 
Configuring means that parameters affecting transducer function can be set. Examples 
of parameters that can be configured are: transformer ratios, curves for analogue 
outputs and baudrates. 

• Reading 
The information that can be read is instant and output values. 

• Remote control 
The Cewe DPT can be used to set both the analogue and digital outputs to a certain 
value without having any input signals. 

• Maintenance 
Examples of maintenance tasks are: resetting the Maximum Demand (MD) values and 
updating the firmware in the meter. 
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Connecting to the transducer 
To be able to configure or read values in the Cewe DPT, ConfigView must be connected and 
have authorisation to access the transducer. The transducer has a password that can be set. See 
the section Communications and security (pg. 26). With the transducer's usual factory 
settings, no password is configured, and subsequently no password is necessary when 
connecting. If the transducer has a password it is still possible to read the settings in the 
transducer. 
 
To communicate with the transducer, the PC must be physically connected to the Cewe DPT 
in one of the following ways: 
 

• PC – USB cable – Transducer 

• PC – Straight serial cable – RS485 converter – Daisy chained transducers 

Note: Auxiliary supply needs to be connected to the Cewe DPT to be able to communicate 
with the transducer. 

A first ever computer USB connect to the transducer 

This chapter is only necessary to do once for every computer, regardless of how many 
transducers are connected to the same computer. 
To be able to communicate via the USB port it is necessary to install the drivers for the USB 
port as a virtual COM-port. 
 

1. Ensure that the transducer has auxiliary power. 
2. Connect the USB mini-B type cable between the transducer and the computer. 
3. An installation shall start automatically and show a similar window as below. 

 

 
 

4. Select the automatic choice and the driver will be downloaded from the transducer. If 
not, the software driver can be found on the installation media together with the 
installation package for ConfigView. 

5. When everything is ready, click OK to finish the installation. 
6. The virtual COM-port that is assigned will be auto detected by ConfigView. To 

identify the virtual COM-port manually it can be found by opening the Control Panel, 
System/Hardware/Device Manager and expand the Com port node. 
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7. Continue to “Usual connection to the transducer”. 

Usual connection to the transducer 

To prepare ConfigView for configuration of a transducer, a connection must be established 
between ConfigView and the transducer. To open a connection, execute the following steps: 
 

  

 

How to connect to the transducer 

1. Select the transducer to connect 
Select a transducer connection by clicking in the left hand tree panel. If there is no transducer 
added start by right click on the top level and add a transducer. 
 
2. Connect to the transducer 
Choose Connect transducer from the File menu or by clicking the toolbar button. 
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3. Communication channel 
Click the Settings tab and choose either, USB (Virtual RS232) or Serial Port (RS485). If the 
serial port is used, the baud rate and parity must be selected. For transducer s with factory 
settings, the baud rate is 9600. 
 
Note: The selectable communication ports are taken from Windows and show every port that 
is assigned to this type of transducer. 
 
4. Response delay 
It is possible to set the response delay of ConfigView. This can be changed if there is a 
problem with the connection and it is suspected that the PC system isn’t fast enough. 
It is also possible to set the RTS delay from the PC so that the last bit(s) of the message isn’t 
cut. 
 
5. Password 
Click the Common tab. If required a password is entered if one is configured in the 
transducer. With the transducer’s factory settings, no password is configured, and 
subsequently no password is necessary when you connect. 
 
6. MODBUS Id 
MODBUS Id is the identification of a transducer on a multi-drop RS485 line. This number is 
only required if a special transducer is to be addressed when several meters are connected 
together with RS485. 
 
7. Click the Connect button. 

Problems with connecting 

If the meter cannot be connected, an error message is displayed. Depending on the reason, the 
message can suggest corrective actions, such as changing the port or port baud rate. 

Basic configuration 
Some basic settings may be required before the Cewe DPT will be able to measure and 
operate correctly in a system. 
 
Note: Settings are only necessary if they have not been made at the factory prior to delivery. 
 
To change the configuration for a transducer, you must be connected to it. Click the 
Configuration folder in the structure tree to the left in ConfigView to display the various 
functions that can be configured. For more information see the section Changing 
configuration (pg. 16). 
 
Tip: You can save a configuration from a transducer to a file. A summary of the configuration 
can also be printed out. You can also create a configuration without being connected to a 
transducer. For more information, see Working with configurations (pg. 16). 
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• Transformer ratios: For the transducer to measure accurately, the ratios for current and 

voltage transformers must be correct. To configure the transformer ratio in ConfigView, 
choose the node Transducer – Configuration – Input configuration in the structure 
tree. Fill in the primary and secondary values for current and voltage. Lowest possible 
voltage and current is 1V respective 0.01A. The ratio between primary and secondary can 
lowest be 0.1. 

 

 
 

Note: The values you choose as primary and secondary values will be considered as 
the nominal values. 

• Measurement method: It is possible to set the correct measurement method with two 
drop down toolbars. A picture will also display the proper way to install the transducer. 
All possible measurement variants are shown in Measuring principles (pg. 8). 

• Analogue output curves: To configure the analogue output curves in ConfigView, 
choose the node Transducer – Configuration – Analogue outputs in the structure tree. 
Find out how Analogue outputs works and how it can be configured in the section 
Analogue outputs (pg. 20). 
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• Pulse constants for pulse outputs: To configure pulse constants for digital pulse outputs 
in ConfigView, choose the node Transducer – Configuration – Digital outputs in the 
structure tree. Find out how Digital outputs works and how it can be configured in the 
section Digital outputs (pg. 23). 

Overview of functions 
The following is a brief overview of the functions available in Cewe DPT. All functions in the 
transducer can be both configured and read in ConfigView. In many cases, ConfigView can 
also export data to a file or print out data. 
 
Function Configuration location in 

ConfigView 
Section in handbook describing 
the function. 

Analogue outputs 
Set the functions for the up to 
four analogue outputs. 

Transducer – Configuration – 
Analogue outputs 

Analogue outputs (pg. 20) 

Digital outputs 
Set the functions for the up to 
two digital outputs. 

Transducer – Configuration – 
Digital outputs 

Digital outputs (pg. 23) 

Instant values 
Presentation of instant values like 
voltage  and current. 

Transducer – Reading – Instant 
values 

Instant values (pg. 24) 

Remote control 
Control the analogue and digital 
outputs regardless of the input  

Transducer – Remote control – 
Remote control of analogue 
outputs and Remote control of 
digital outputs 

Remote control (pg. 25) 

Password 
A correct password will allow 
changing of configuration in a 
password protected transducer. 

Transducer – Tools – Change 
Password. 

Communications and security 
(pg. 26) 

Communication speed 
Set the baud rate for the 
transducer’s serial ports. 

Transducer – Configuration – 
Communication and security 

Communications and security 
(pg. 26) 

Maximum demand 
Determine values that are to be 
stored as maximum average 
values. 

Transducer – Configuration – 
Input configuration 

Average and Maximum 
Demand 
(pg. 27) 

Information texts 
Enter information text that can be 
implemented in configuration 
summary. 

Transducer – Configuration – 
General 

Miscellaneous (pg. 28) 

Customer serial number 
A possibility to add a customer 
unique serial number 

Transducer – Configuration – 
General 

Miscellaneous (pg. 28) 
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Changing configuration 

 
 
To open a configuration form, click the folder Configuration in the structure tree and then 
click one of the nodes: Input configuration, Analogue outputs etc. Configuration changes 
can be made in all configuration forms. In the lower right corner, there is an Apply button. If 
a transducer is connected and you click Apply, changes to the configuration will be 
immediately transferred to the transducer. 

Working with configurations 
In ConfigView, you can work with configurations as a collection of the Cewe DPT’s settings 
and save them in a file. On ConfigView 's File menu, are the commands Save configuration 
and Open configuration. On the View menu, there is a command for creating a configuration 
summary. Below is a list of how you can use ConfigView 's functions to work with 
configurations. 
 

• Creating a configuration file without being connected to a transducer 
Any changes to the configuration can be applied and then saved as a configuration. 
Make all settings that are to be included in the configuration file and save the file. The 
file's configuration can later be transferred to a transducer. 

• Saving a transducer's configuration to a file 
Choose Save configuration when ConfigView is connected to a transducer to save the 
transducer's configuration to a file. The configuration file can later be used as a backup 
or be transferred to another transducer. 

• Transferring a configuration file to a meter 
Choose Open configuration when ConfigView is connected to a transducer to 
transfer a configuration file. 

• Printing out a summary of a transducer's configuration 
Choose View– Configuration summary when ConfigView is connected to a 
transducer to create a summary of the transducer's entire configuration. Now choose 
Print. 

• Printing out a summary of a configuration file 
Open a configuration file and choose View – Configuration summary to create a 
summary of the configuration that is in the file. Together with a Print option there is 
also options for export to either Excel- or pdf-file. 

 

Note: Choosing Open configuration when ConfigView is connected to a transducer opens a 
warning dialog box with the message that the configuration in the transducer will be written 
over if you continue. 
Note: A configuration that is done offline must be saved before connecting to the transducer. 
Otherwise it will be overwritten by the configuration in the transducer. 
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Reading 

 
If you are connected to a Cewe DPT two alternatives will be available in the structure tree 
under the node Reading. The displayed values are constantly updated. Read values can be 
printed out as a snapshot of the time when the print command was issued. It is also possible to 
save as a snapshot or do a continuously saving of data every second. A pop-up dialog will ask 
where the data should be saved in the system. 

Information about the transducer 

 
Information about the connected transducer can be obtained by choosing View – Information 
about the transducer. This information is vital when contacting support if you encounter 
problems with the transducer. 
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Versions and version conflicts 
The latest version of ConfigView can be used with all firmware (application) versions of 
Cewe DPT. The version number for ConfigView is displayed on the application's title bar or 
under About ConfigViewPT on the Help menu. The version number for the transducer's 
firmware  can be viewed under Information about the transducer on the View menu. 
 
Cewe DPT and ConfigView have three-digit version numbers according to the format main 
version.sub-version.build number. As long as the main version and sub-version are the same, 
ConfigView and the transducer are compatible. If the transducer firmware is of a newer 
version than ConfigView and the main version and/or sub-version are different, ConfigView 
will display a message that connection is not possible. ConfigView must be updated. 

Upload new firmware 
Cewe DPT is designed to be able to receive updated firmware via the serial ports. Newly 
developed and improved functions can thus be added in a transducer that lacked these 
functions when delivered. 
 
Note 1: Be sure to upgrade ConfigView to the latest version before upgrading the transducer. 
There is otherwise the risk that ConfigView will no longer be version-compliant after 
firmware upload. 
Note 2: The USB serial port shall be used when uploading new firmware unless it is 
absolutely necessary to use RS485. If RS485 is used when uploading Modbus is not used. 
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On the Tools menu, there is an Upload firmware command when the transducer is connected 
with the correct password or when no password is set. Begin by choosing the file that contains 
the update. The file name and version number will then be displayed, and sometimes a 
message. Check the box Show details about the upload to view more information about the 
upload. Click Update to begin updating. 
 
During the time the update is being installed, the transducer stops measuring. Depending on 
the size of the file to be transferred and the baud rate, the time for updating will vary. If 
possible, connect at the highest baud rate (38400 bps) to speed updating. After updating, the 
transducer is restarted automatically to complete installation of the transducer's new firmware. 

Language 
ConfigView can be set to different languages. The available languages can be seen under 
Language on the View menu. 

Resetting MD values 
The Maximum Demand values in the Cewe DPT can be set to zero with Zero MD values on 
the Tools menu. 
Both average demand and MD values will be set to zero when the auxiliary is lost.  
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Functions 
Analogue outputs 
The Cewe DPT has up to four analogue outputs that can be configured to either remote 
control or to output a current or voltage signal that reflects to any of the measured quantities. 
They have an isolated interface between the electronics and the surroundings to ensure 
personal safety. For electrical data on the transducer’s outputs, see Appendix G – Technical 
specification (pg. 62). 

Outputs 

The outputs can be configured as follows: 

• Inactive 
The output is not used. The output will be set to 0 mA or 0V, depending on the 
configuration. 

• Remote control 
With this function, the output can be made active without having any input signals to 
the transducer. For more information, see Remote control (pg. 25) 

• Measurand quantity 
This defines which of the quantities measured by the transducer will be reflected on 
the output. Most of the quantities also need to be selected for a phase or the complete 
system. The unit for the selected measurand is shown to the right of the two drop 
down lists. 
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Quantity By phase Total Unit 
Active power Yes Yes W 
Reactive power Yes Yes var 
Apparent power Yes Yes VA 
Active power factor P/S Yes Yes  
Reactive power factor Q/S Yes Yes  
LF factor SgnQ(1 –|PF|) Yes Yes  
Frequency Not applicable Yes Hz 
Current Yes Yes A 
Phase voltage Yes Yes V 
Phase to phase voltage Yes Yes V 
Current with sign Yes Yes A 
Phase angle  Yes Yes rad 
Phase angle voltage (phase to 
neutral) 

Yes Not applicable rad 

Phase angle voltage (ph-ph) Yes Not applicable rad 
Phase angle current Yes Not applicable rad 
THD current Yes Not applicable % 
THD voltage Yes Not applicable % 
Average current Yes Yes A 
MD current Yes Yes A 
Average active power Yes Yes W 
MD active power import Yes Yes W 
MD active power export Yes Yes W 
Average reactive power Yes Yes var 
MD reactive power import Yes Yes var 
MD reactive power export Yes Yes Var 
Average apparent power Yes Yes VA 
MD apparent power Yes Yes VA 

Breakpoints 
There must always be two end points to define the max and min values of the output. Up to 
seven additional breakpoints can be defined between the end points. Each end point and 
breakpoint is a pair of numbers mapping the measured unit (for instance Watt for active 
power) to the output unit (for instance A for a current output). Note that the hardware 
configuration of the output is shown in brackets in this area (for example [-20mA .. 20mA]. 
There is a 10% over range on the defined hardware configuration. 
It is always possible to change or delete all added breakpoints. 

Accuracy 
The accuracy of each of the analogue outputs at full value is in worst case an additional 
0,05% over the bus value, see Bus accuracy (pg. 24). At lower values the error will increase. 
It is recommended not to use an analogue output in a low range that is covered by another 
hardware variant of the Cewe DPT. For instance a -20mA .. 20mA hardware should not be 
used as a -5mA – 5mA output as there is a separate hardware for this range. 
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Response time 

Response time can be used to filter the changes in output. It defaults to 300ms and is 
programmable between 200 ms to 60 seconds. 
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Digital outputs 
The Cewe DPT has two digital outputs that can be configured to perform various tasks. They 
are protected against overvoltages by varistors. They also have an isolated interface between 
the electronics and the surroundings to ensure personal safety. For electrical data on the 
transducer’s outputs, see Appendix G – Technical specification (pg. 62). 

Outputs 

The outputs can be configured as follows: 

• Not used 
The output is not used. It is set to open condition. 

• Pulse output 
The output is used to pulse a energy type that the transducer is measuring. A pulse 
constant is specified for the output as primary pulses/unit as well as the pulse length. 
The shortest possible pulse length is 10 ms. Pulses are not allowed to come too often, 
and because of this, there is a relationship between the pulse length and the specified 
pulse constant that maximises the pulse frequency to 1000/(pulse length(ms) * 2). 
 

Pulse Gap
 

Maximum pulse frequency at outputs is limited so that the gap is at least as long as the 
pulse length. 
 
The pulse outputs can be inverted. Note that outputs are inverted via firmware. If the 
meter loses its auxiliary power, the relay will open, regardless if it is inverted or not. 

• Remote control 
With this function, the output can be made to switch between open and closed without 
having any input signals to the transducer. For more information, see Remote control 
(pg. 25) 

Accuracy of the pulse output 

The accuracy of each of the digital outputs is ± 0,30% of full scale value for all connections 
except when the neutral (N) is not connected, see system No 3 in Appendix B – Network 
System Connection Diagrams (pg. 47). 
To achieve this accuracy the minimum measured period is 30 seconds. 
The outputs comply with 0.5s accuracy. 
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Instant values 
Besides being a transducer, the Cewe DPT can also measure and present instant values. 
Instant values are constantly changing values such as current, voltage, power and harmonics.  

Overview 

The table in Measured Quantities (pg. 29) provides an overview of the instant values that can 
be read with the transducer. Readings can be viewed with ConfigView or with other software 
that has implemented Cewe DPT’s communication protocol. 

Update frequency 

The update frequency for instant values is proportional to the frequency of the measured 
quantity. At 50 Hz updating occurs 12.5 times per second, and at 60 Hz, 15 times per second. 

Response time for instant values on the bus 

For the two serial ports it is possible to get a response time of 200 ms for all instant values as 
long as the communication is set to 9600 baud or higher. 

Bus accuracy 

The table shows the accuracy for a Cewe DPT with accuracy class 0.2 for a selection of 
instant values. The basic accuracy is valid under reference conditions acc. to IEC/EN 60688. 

Instant value Accuracy  Instant value Accuracy 
Voltage ± 0,2% FS1  Frequency ± 0,01 Hz 
Current ± 0,2% FS  Voltage unbalance ± 0,2% 
Power ± 0,2% FS2  THD Voltage and 

current 
± 0,5% 

Power factor ± 0,1°    

Additional error due to system/application configuration 
Neutral N not connected, see system No 3 in Appendix B – Network System Connection 
Diagrams (pg. 47). 
 

Instant value Additional error 
Voltage 0,1% 
Power 0,1% 
Power factor 0,1° 
Phase angle 0,1° 

THD 

THD stands for Total Harmonics Distortion and is a measurement of the amount of harmonics 
present in a signal. Voltage and current THD can be read via ConfigView up to the 31st 
harmonic. 
 

                                                 
1 FS: Maximum of the input configuration (Full Scale). Up to 50% of  3rd and 10% of  5th harmonics. 
2 FS: (FSVoltage)x(FSCurrent). Up to 50% of  3rd and 10% of  5th harmonics 
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Remote control 

Remote control of analogue outputs 

If one or more analogue output(s) has been configured as remote control the output can be set 
to any value within the range of the output. For example a -20 mA to 20 mA output can be set 
to any value with four decimals within that range. 

Remote control of digital outputs 

If one or more digital output(s) has been configured as remote control the output can be set to 
be open or closed. 
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Communications and security 
All Cewe DPT are equipped with an USB and a RS485 port for communication. It supports 
USB 2.0 and MODBUS protocol. For more information on protocol support, see Modbus 
Map (pg. 37). 

Communication speed 

The transducer’s USB port always runs at 38400 baud and is fully auto configured from the 
system. 
The RS485 needs to be set to the correct baudrate to have a successful connection. The 
baudrate can be set between 1200 bps and 38400 bps. 
The factory settings for the RS485 channel are 9600 bps, even parity and one stop bit. 
It is possible to set the transducers response delay in ms. When connecting to the transducer it 
is also possible to set the RTS (request to send) delay in ms.  

MODBUS address 

A bus address can be defined for the RS485 port and it is necessary to use a unique bus 
address as soon as there is more than one transducer on the RS485 bus. Any number between 
1 and 247 is accepted. 

Password and security 

The transducer has a password that will limit the access to show everything but not allowing 
configuration or remote control. 
The password can consist of up to 40 case insensitive alpha-numerical characters. 
To change the password, first enter the old and then the new password twice. The new 
password will be activated after a reconnect of the transducer. 
The default for the transducer is to have no password. 
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Average and Maximum Demand 
These two functions are used to output a static average value on one or more analogue outputs 
during the time interval set as the integration time under Configuration/Input. Both functions 
are calculated and presented every minute regardless of the time interval set. The average 
value is always presented on the analogue output. If the new average value exceeds the 
previously stored value for maximum demand, it becomes the new value for maximum 
demand. 
The calculation interval can be chosen between 1 and 60 minutes in whole minutes. Before 
the first interval has been finished the output will be set to 0 mA or 0 V. 

Average 

Other name: Bimetal. 
 
This function averages the measurand over the time interval. When the interval is finished the 
analogue output will change to the new value, regardless if it is higher or lower than the 
previous. 

Possible measurands 
Average current 
Average active power 
Average reactive power 
Average apparent power 

Maximum Demand (MD) 

Other name: Slave pointer. 
 
This function averages the measurand over the time interval. When the interval is finished the 
analogue output will change to the new value if it is higher than the previous stored value. 
This value always measures the import value for the measurands and can therefore never be a 
negative value. Note that for active and reactive power, ‘export’ corresponds to the largest 
negative value, while ‘import’ corresponds to the largest positive value of the average. 

Possible measurands 
MD current 
MD active power import 
MD active power export 
MD reactive power import 
MD reactive power export 
MD apparent power 

Resetting MD 

The values in the Cewe DPT can be set to zero with Zero MD values on the Tools menu. 
 
Note: Average values will be reset if the transducer is disconnected from the auxiliary power, 
while the maximums will be retained. 
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Miscellaneous 

Description 

It is possible to type an own description with a maximum of 32 characters that will be seen in 
the configuration summary. 

Customer serial number 

There are two serial numbers in the transducer that can be used. The default serial number is 
set from factory and can not be changed. It is possible to set an own serial number to 
recognise the transducer. This serial number can be of maximum 20 characters. If such a 
serial number is added that is what will be shown in the tree structure in ConfigView and in 
configuration summary. It is possible to step back to the factory serial number by removing 
the customer serial number. 
It is always the factory serial number that is presented in the ‘Information about the 
transducer’ menu. 
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Measured Quantities 
Instant value Phase Quantity 
Active power of the system P = P1 + P2 + P3 System P 
Active power on phase  L1 L1 P1 
Active power on phase  L2 L2 P2 
Active power on phase  L3 L3 P3 
Reactive power of the system Q = Q1 + Q2 + Q3 System Q 
Reactive power on phase  L1 L1 Q1 
Reactive power on phase  L2 L2 Q2 
Reactive power on phase  L3 L3 Q3 
Apparent power of the system S=S1+S2+S3 System S 
Apparent power on phase  L1 L1 S1 
Apparent power on phase  L2 L2 S2 
Apparent power on phase  L3 L3 S3 
Average power factor on all phases L1, L2, L3    cosφ = P/S System PF 
Power factor on phase L1 (cosφ on phase L1)   P1/S1 L1 PF1 
Power factor on phase L2 (cosφ on phase L2)   P2/S2 L2 PF2 
Power factor on phase L3 (cosφ on phase L3)   P3/S3 L3 PF3 
Average power factor on all phases L1, L2, L3    sinφ = Q/S System QF 
Power factor on phase L1 (sinφ on phase L1)    Q1/S1 L1 QF1 
Power factor on phase L2 (sinφ on phase L2     Q2/S2 L2 QF2 
Power factor on phase L3 (sinφ on phase L3)    Q3/S3 L3 QF3 
LF = sgnQ x (1 –|PF|) System LF 
LF = sgnQ1 x (1 –|PF1|) L1 LF1 
LF = sgnQ2 x (1 –|PF2|) L2 LF2 
LF = sgnQ3 x (1 –|PF3|) L3 LF3 
Frequency System F 
Phase angle mean arctan (Q/P) System PA 
L1 Phase angle between voltage and current (Rad) L1 PA1 
L2 Phase angle between voltage and current (Rad) L2 PA2 
L3 Phase angle between voltage and current (Rad) L3 PA3 
Phase angle phase-N voltage (Rad)     Reference (usually=0) L1 PAU1 
Phase angle phase-N voltage (Rad) L2 PAU2 
Phase angle phase-N voltage (Rad) L3 PAU3 
Phase angle current (Rad) L1 PAI1 
Phase angle current (Rad) L2 PAI2 
Phase angle current (Rad) L3 PAI3 
Phase angle phase-phase voltage (Rad) L1 PAU12 
Phase angle phase-phase voltage (Rad) L2 PAU23 
Phase angle phase-phase voltage (Rad) L3 PAU31 
Average system current (Instantaneous System current)  (I1+I2+I3)/3 System I 
L1 current L1 I1 
L2 current L2 I2 
L3 current L3 I3 
I and sign of active power (output magnitude and polartity) 
Active currents, average line currents  IS=(IS1+IS2+IS3)/3*signP System IS 
Active currents L1 IS1 
Active currents L2 IS2 
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Active currents L3 IS3 
System voltage average L1-L3 (Phase-N)  
Average System Voltage U=(U1+U2+U3)/3  System U 
L1 Phase-N voltage L1-N U1N  
L2 Phase-N voltage L2-N U2N 
L3 Phase-N voltage L3-N U3N 
L1-L2 Phase-phase voltage L1-L2 U12 
L2-L3 Phase-phase voltage L2-L3 U23 
L3-L1 Phase-phase voltage L3-L1 U31 
THD L1-N voltage L1-N THDU1 
THD L2-N voltage L2-N THDU2 
THD L3-N voltage L3-N1 THDU3 
THD L1-L2 voltage L1-L2 THDU12 
THD L2-L3 voltage L2-L3 THDU23 
THD L3-L1 voltage L3-L1 THDU31 
THD L1 Current L1 THDI1 
THD L2 Current L2 THDI2 
THD L3 Current L3 THDI3 
Demand of system current    DI1+DI2+DI3 System DI 
Demand of L1 current L1 DI1 
Demand of L2 current L2 DI2 
Demand of L3 current L3 DI3 
Maximum demand of system current System MDI 
Maximum demand of L1 current L1 MDI1 
Maximum demand of L2 current L2 MDI2 
Maximum demand of L3 current L3 MDI3 
Demand of system active power    DP1+DP2+DP3 System DP 
Demand of L1 active power L1 DP1 
Demand of L2 active power L2 DP2 
Demand of L3 active power L3 DP3 
Maximum demand of system active power import System MDPImp 
Maximum demand of L1 active power import L1 MDP1Imp 
Maximum demand of L2 active power import L2 MDP2Imp 
Maximum demand of L3 active power import L3 MDP3Imp 
Maximum demand of system active power export System MDPExp 
Maximum demand of L1 active power export L1 MDP1Exp 
Maximum demand of L2 active power export L2 MDP2Exp 
Maximum demand of L3 active power export L3 MDP3Exp 
Demand of system reactive power    DQ1+DQ2+DQ3 System DQ 
Demand of L1 reactive power L1 DQ1 
Demand of L2 reactive power L2 DQ2 
Demand of L3 reactive power L3 DQ3 
Maximum demand of system reactive power import System MDQImp 
Maximum demand of L1 reactive power import L1 MDQ1Imp
Maximum demand of L2 reactive power import L2 MDQ2Imp
Maximum demand of L3 reactive power import L3 MDQ3Imp
Maximum demand of system reactive power export System MDQExp 
Maximum demand of L1 reactive power export L1 MDQ1Exp
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Maximum demand of L2 reactive power export L2 MDQ2Exp
Maximum demand of L3 reactive power export L3 MDQ3Exp
Demand of system apparent power    DS1+DS2+DS3 System DS 
Demand of L1 apparent power L1 DS1 
Demand of L2 apparent power L2 DS2 
Demand of L3 apparent power L3 DS3 
Maximum demand of system apparent power System MDS 
Maximum demand of L1 apparent power L1 MDS1 
Maximum demand of L2 apparent power L2 MDS2 
Maximum demand of L3 apparent power L3 MDS3 
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Quantities measured for each system 
 
x the quantity can be sent on all communication channels and be presented on analogue 

output. 
y the quantity can only be presented via MODBUS and USB. 
 
Measured Quantity 
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Active Power P x x x x x x x  

 P1 x x      x 

 P2 x y       

 P3 x y       

Reactive Power Q x x x x x x x  

 Q1 x x      x 

 Q2 x y       

 Q3 x y       

Apparent Power S x x x x x x x  

 S1 x x      x 

 S2 x y       

 S3 x y       

Power Factor PF x x x x x x x  

 PF1 x x      x 

 PF2 x y       

 PF3 x y       

Reactive Power Factor QF x x x x x x x  

 QF1 x x      x 

 QF2 x y       

 QF3 x y       
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Measured Quantity 
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Alt. Reactive Power Factor 
(sgn Q * (1 - |PF1|) 

LF x x x x x x x  

 LF1 x x      x 

 LF2 x y       

 LF3 x y       

Frequency F x x x x x x x x 

Current I x x x x x x x  

 I1 x x x x x x x x 

 I2 x y y y y y y  

 I3 x y x y y y y  

Current with sign from 
Active Power 

IS x x       

 IS1 x x      x 

 IS2 x y       

 IS3 x y       

Voltage U x x       

 U1 x x      x 

 U2 x y       

 U3 x y       

 U12 x x x x x y y  

 U23 x x x x y x y  

 U31 x x x x y y x  

Analogue Output O1 x x x x x x x x 

 O2 x x x x x x x x 

 O3 x x x x x x x x 

 O4 x x x x x x x x 

Phase Angle U-I PA x x x x x x x  

 PA1 x x      x 

 PA2 x y       

 
 

PA3 x y       
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Measured Quantity 
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Phase Angle relative U1 PAU1 x x      x 

 PAU2 x y       

 PAU3 x y       

 PAI1 x x x x x x x x 

 PAI2 x y y y y y y  

 PAI3 x y x y y y y  

 PAU12   x x x y y  

 PAU23   x x y x y  

 PAU31   x x y y x  

THD THDU1 x x      x 

 THDU2 x y       

 THDU3 x y       

 THDI1 x x x x x x x x 

 THDI2 x y y y y y y  

 THDI3 x y x y y y y  

 THDU12   x x x y y  

 THDU23   x x y x y  

 THDU31   x x y y x  

Demand of Current DI x x x x x x x  

 DI1 x x x x x x x x 

 DI2 x y y y y y y  

 DI3 x y x y y y y  

Max Demand of Current MDI x x x x x x x  

 MDI1 x x x x x x x x 

 MDI2 x y y y y y y  

 MDI3 x y x y y y y  

Demand of Active Power DP x x x x x x x  

 DP1 x x      x 
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Measured Quantity 
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Demand of Active Power 
(cont’d) 

DP2 x y       

 DP3 x y       

Max Demand of Active 
Power Import 

MDPImp x x x x x x x  

 MDP1Imp x x      x 

 MDP2Imp x y       

 MDP3Imp x y       

Max Demand of Active 
Power Export 

MDPExp x x x x x x x  

 MDP1Exp x x      x 

 MDP2Exp x y       

 MDP3Exp x y       

Demand of Reactive Power DQ x x x x x x x  

 DQ1 x x      x 

 DQ2 x y       

 DQ3 x y       

Max Demand of Reactive 
Power Import 

MDQImp x x x x x x x  

 MDQ1Imp x x      x 

 MDQ2Imp x y       

 MDQ3Imp x y       

Max Demand of Reactive 
Power Export 

MDQExp x x x x x x x  

 MDQ1Exp x x      x 

 MDQ2Exp x y       

 MDQ3Exp x y       

Demand of Apparent 
Power 

DS x x x x x x x  

 DS1 x x      x 

 DS2 x y       

 DS3 x y       

Max Demand of Apparent 
Power 

MDS x x x x x x x  
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Measured Quantity 
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 MDS1 x x      x 

 MDS2 x y       

 MDS3 x y       
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Modbus Map 
Introduction 

Background and Scope 

The Cewe DPT uses the Modbus protocol for configuration and data communication. The 
Modbus protocol supports reading and writing of a number of registers. The meaning of the 
registers is application dependent. This section specifies the meaning of the Modbus registers 
(the Modbus mapping) for the Cewe DPT  as far as reading is concerned. If the writing 
registers also are interesting, please contact Cewe Instrument. 
The document also defines general requirements and limitations on the communication 
properties of the transducer. 
The transducer Modbus Map specified in this document is version 1. 

References 

1 Modbus Application Protocol Specification V1.1b 
2 Modbus over serial line specification and implementation guide V1.02 

General concepts 

Modbus over serial line 

The Cewe DPT implements Modbus over serial line using the RTU transport protocol 
according to [1] and [2]. 

Slave addressing 

The Cewe DPT has Modbus slave address 1 as default. 

Register Addressing 

The transducer uses two of the possible four Modbus data blocks: Input Registers and 
Holding Registers. The data blocks have separate address spaces. For instance address 0003 
means output type for output line 1 in the Holding Register block, but active power on L1 in 
the Input Register block. 
 
Addresses in this document are given as data element address, which is Modbus PDU address 
+ 1. To get Modbus PDU address, subtract 1 from addresses given in this document. 

Serial port configuration 

For the RS485 port the following attributes can be configured: 
Parity (none, even or odd, default even) 
Stop bits (1 or 2, 1 is default) 
Baud rate (1200, 2400, 4800, 9600, 19200, 9600 is default) 
Databits is always 8. 
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According to [2] total number of bits must always be 11, including the start bit. The 
transducer does however also support no parity and only one stopbit, giving a total of 10 bits, 
since this is common among Modbus equipment. 
 
The USB port does not need any port specific configuration. 

Security 

The default configuration of the transducer allows configuration on the RS485 port. To block 
configuration changes on that port, set the configuration property ‘Allow configuration on the 
RS485 port’ (0x0213) to 0x0000. This can also be done in ConfigView software. 

Down time during configuration 

While the configuration settings are changing, after a commit, the transducer may leave its 
ordinary mode of operation for up to two seconds. During this period, outputs will remain as 
they were prior to the configuration change. 

Modbus function codes 

Supported function codes 
The transducer supports the following Modbus function codes: 
 
Function 
code 

Description Comment 

3 Read Holding Registers  
4 Read Input Registers  
6 Write Single Register  
8 Diagnostics Only allowed on RS485 if configured so. 
11 Get Comm Event Counter  
12  Get Comm Event Log  
16 Write Multiple Registers  
23 

Registers 
Read/Write Multiple  

43  Interface 
vice 

Identification 

. 
 

bytes product code, and 8 bytes firmware 
ersion. These will be strings padded with 

spaces as follows: 
endor: Cewe Instrument 
roduct Code: DPT 

Version: x.y.z 

Encapsulated
Transport/de

Only supports MEI type 14, conformity 01
Will return 16 bytes with vendor name, 16

v

V
P
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Unsupported function codes 
The codes l ined in [1] b  result 
in ILLEGAL FUNCTION (0x01) exception code. The same is true for 
explicitly li ported function
 
Function 
code 

Description 

isted below are def

sted in the ‘sup

ut not supported by the transducer, and will
any function code not 

 codes’ above. 

Comment 

1 Read Coils  
2 Read Discrete Inputs  
5 Write Single Coil  
7 Read Exception Status  
15 Write Multiple Coils  
17 Report Slave ID Read appropriate holding registers instead. 
20 Read File Record  
21 Write File Record  
22 Mask Write Register  
24 Read FIFO Queue  
43 Encapsulated Interface 

Transport 
Not supported except MEI type 14 as 
described above 

Configuration registers 
This section defines registers used to configure the transducer. Configuration registers are 
implemented as Holding Registers. 

Data types 

All holding registers are unsigned 16 bit big-endian integers according to the Modbus 
specification.  
Signed 16 bit integers are represented as big-endian 2-complement. 
Q values are represented as signed 16 bit integers. 
ASCII fields are packed two characters per register. 
32 bit integers are stored as two registers, most significant first. 
Floats are stored in two registers as single precision according to IEEE 754. 

Registers 

When reading or writing multiple holding registers in one operation, it never allowed to span 
an address that is undefined. Trying to read an undefined address will cause an Illegal Data 
Address (02) exception response. 
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Holding registers 

The below registers are the one that can be used for remote communication with the Cewe 
DPT. Note: if any holding registers shall be used with a Cewe DPT that uses password, please
contact Cewe Instrument for more information. 

 

P Datatype and values 
 
Decimal roperty 
548 Customer serial number 10 addresses for customer serial number, 

typically interpreted as null terminated 
string, 2 characters per address. Must be 
read and written completely and alone in a 
single Modbus message. 

777 Serial number 2 words (can be interpreted as 32 bit 
unsigned integer). Read only. 

1297 Remote control O1 32 bit float in V or A (dep. on hardware) 
1299 R 32 bit float in V or A (dep. on hardware) emote control O2 
1301 R 32 bit float in V or A (dep. on hardware) emote control O3 
1303 Remote control O4 32 bit float in V or A (dep. on hardware) 
1312 R  

D1 
0 or 1 emote control D1/Read

1313 R ad 
D2 

0 or 1 emote control D2/Re

Data reg
plemented as Input Registers in the transducer 

dbus ma

culated

All calculated values are represented as two consecutive Modbus registers. The value of a 
ntity is  precisio  floating point number according to IEEE 754, in 
nit. 

 

Address 
Pha

isters 
The following data values are read only and im
Mo p. 

Cal  Values 

qua
SI u

represented as a single n

(dec) Quantity se Explanation 
1 P Sys

P3 
tem Active power of the system P = 

P1 + P2 + 
3 P1 L1 Active power on phase  L1 
5 P2 L2 Active power on phase  L2 
7 P3 L3 Active power on phase  L3 
9 Q System Reactive power of the system Q 

= Q1 + Q2 + Q3 
11 Q1 L1 Reactive power on phase  L1 
13 Q2 L2 Reactive power on phase  L2 
15 Q3 L3 Reactive power on phase  L3 

 
17 S System Apparent power of the system 
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S=S1+S2+S3 
19 S1 L1 Apparent power on phase  L1 
21 S2 L2 Apparent power on phase  L2 
23 S3 L3 Apparent power on phase  L3 
25 PF System Average power factor on all 

phases L1, l2,L3     cosφ = P/S 
27 PF1 L1 Power factor on phase L1 (cosφ 

on phase L1)   P1/S1 
29 PF2 L2 Power factor on phase L2 (cosφ 

on phase L2)   P2/S2 
31 PF3 L3 Power factor on phase L3 (cosφ 

on phase L3)   P3/S3 
33 QF System Average power factor on all 

phases L1-L3         sinφ = Q/S 
35 QF1 L1 Power factor on phase L1 (sinφ 

on phase L1)    Q1/S1 
37 QF2 L2 Power factor on phase L2 (sinφ 

on phase L2     Q2/S2 
39 QF3 L3 Power factor on phase L3 (sinφ 

on phase L3)    Q3/S3 
41 LF System LF = sgnQ · (1 –|PF|) 
43 LF1 L1 LF1 = sgnQ1 · (1 –|PF1|) 
45 LF2 L2 LF2 = sgnQ2 · (1 –|PF2|) 
47 LF3 L3 LF3 = sgnQ3 · (1 –|PF3|) 
49 F System Frequency 
51 I System Average System current 

I = (I1 + I2 + I3) / 3 
53 I1 L1 I1 current 
55 I2 L2 I2 current 
57 I3 L3 I3 current 
59 IS  I with sign of active power. 

IS = (IS1 + IS2 + IS3) / 3 * signP 
61 IS1 L1 IS1 = sgnP1 · I1 
63 IS2 L2 IS2 = sgnP2 · I2 
65 IS3 L3 IS3 = sgnP3 · I3 
67 U System Average System Voltage (Phase-

N). 
U = (U1 + U2 + U3) / 3 

69 U1 L1 U1 voltage (Phase-N) 
71 U2 L2 U2 voltage (Phase-N) 
73 U3 L3 U3 voltage (Phase-N) 
75 U12 L1-L2 U12 voltage (Phase-Phase) 
77 U23 L2-L3 U23 voltage (Phase-Phase) 
79 U31 L3-L1 U31 voltage (Phase-Phase) 
81 O1 NA Output value 1, unit (V or A) 

depends on system configuration. 
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83 O2 NA Output value 2, unit (V or A) 
depends on system configuration. 

85 O3 NA Output value 3, unit (V or A) 
depends on system configuration. 

87 O4 NA Output value 4, unit (V or A) 
depends on system configuration. 

89 PA Sy ween voltage and 
current 

stem Phase angle bet

System means atan(Q/P) 
91 PA1 L1 Phase angle between voltage and 

current (Rad) 
93 PA2 L2 Phase angle between voltage and 

current (Rad) 
95 PA3 L3 Phase angle between voltage and 

current (Rad) 
97 PAU1 L1 Phase angle voltage (Rad) 
99 PAU2 L e (Rad) 2 Phase angle voltag
101 PAU3 L3 Phase angle voltage (Rad) 
103 PAI1 L1 Phase angle current (Rad) 
105 PAI2 L2 Phase angle current (Rad) 
107 PAI3 L d) 3 Phase angle current (Ra
109 PAU12 L1-L2 Phase angle voltage (Rad) 
111 PAU23 L2-L3 Phase angle voltage (Rad) 
113 PAU31 L3-L1 Phase angle voltage (Rad) 
115 THDU1 L1 THD of U1 
117 THDU2 L2 THD of U2 
119 THDU3 L3 THD of U3 
121 THDI1 L1 THD of I1 
123 THDI2 L2 THD of I2 
125 THDI3 L3 THD of I3 
127 THDU12 L1-L2 THD of U12 
129 THDU23 L2 THD of U23 -L3 
131 THDU31 L3-L1 THD of U31 
133 DI System Demand of current 

DI = DI1 + DI2 + DI3 
135 DI1 L1 Demand of current on L1 
137 DI2 L Demand of current on L2 2 
139 DI3 L3 Demand of current on L3 
141 MDI System Maximum demand of current. 

MDI = MD1 + MD2 + MD3 
143 MDI1 L1 Maximum demand of current on 

L1. 
145 MDI2 L2 Maximum demand of current on 

L2. 
147 MDI3 L3 Maximum demand of current on 

L3. 
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149 DP System Demand of active power. 
DP = DP1 + DP2 + DP3 

151 DP1 L1 Demand of active power on L1 
153 DP2 L2 Demand of active power on L2 
155 DP3 L3 Demand of active power on L3 
157 MDPImp System Maximum demand of active 

power. 
159 M  Maximum tive DP1Imp L1  demand of ac

power on L1. 
161 MDP2Imp L2 and of active Maximum dem

power on L2. 
163 MD p  P3Im L3 Maximum demand of active

power on L3. 
165 DQ 

 + DQ3 
System Demand of reactive power. 

DQ = DQ1 + DQ2
167 DQ1 L1 L1 Demand of reactive power on 
169 DQ2 L2 L2 Demand of reactive power on 
171 DQ3 L3 L3 Demand of reactive power on 
173 MDQImp System aximum demand of reactive M

power import. 
175 MDQ1Imp L1 and of reactive Maximum dem

power import on L1. 
177 MD mp Q2I L2 Maximum demand of reactive 

power import on L2. 
179 MD mp e Q3I L3 Maximum demand of reactiv

power import on L3. 
181 DS System 

S3 
Demand of apparent power. 
DS = DS1 + DS2 + D

183 DS1 L1 Demand of apparent power on 
L1 

185 DS2 L2 Demand of apparent power on 
L2 

187 DS3 L3 Demand of apparent power o
L3 

n 

189 MDS System 

 

Maximum demand of apparent 
power. 
MDS = MDS1 + MDS2 + MDS3

191 MDS1 L1 pparent Maximum demand of a
power on L1. 

193 MDS2 L2 pparent Maximum demand of a
power on L2. 

195 MDS3 rent L3 Maximum demand of appa
power on L3. 

197 MDPExp System e 
rt. 

Maximum demand of activ
power expo

199 MDP1Exp ive 
power export on L1. 

L1 Maximum demand of act
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201 MDP2Exp L2 f active 
power export on L2. 
Maximum demand o

203 MDP3Exp and of active 
rt on L3. 

L3 Maximum dem
power expo

205 MDQExp System and of reactive Maximum dem
power export. 

207 MDQ1Exp L1 
1. 

Maximum demand of reactive 
power export on L

209 MDQ2Exp d of reactive 
2. 

L2 Maximum deman
power export on L

211 MDQ3Exp 
er export on L3. 

L3 Maximum demand of reactive 
pow
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Appendix B – Network System Connectio
iagrams 

n 
D
4-wire system, 3 element asymmetric load (Y) 

direct connected direct connected voltages and external 
current transformers 
 

external voltage and current transformers  
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4-wire system, 3 element balanced load (U1-I1) 

direct connected direct connected voltage and external current 
transformer 
 

external voltage and current transformers  
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3-wire system, 2 element asymmetric load (D) 

direct connected direct connected voltages and external 
current transformers 

Two external voltage and current 
transformers 
 

 

Three external voltage transformers and two 
current transformers 
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3-wire system, 2 element balanced load (U12-U23-I) 

 
direct connected direct connected voltages and external 

current transformer 
 

external voltages and current transformers  

 

50  



 

3-wire system, 2 element balanced system and load (U12-I1) 

 
direct connected direct connected voltage and external cu

transformer 
rrent 

 

external voltage and current transformers  
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3-wire system, 2 element balanced system and load (U23-I1) 

direct connected direct connected voltage and external cu
transformer 

rrent 

 

external voltage and current transformers  
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3-wire system, 2 element balanced system and load (U31-I1) 

direct connected direct connected voltage and external current 
transformer 
 

external voltage and current transformers  
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Single phase system 

direct connected direct connected voltage and external current 
transformer 
 

external voltage and current transformers  
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Appendix C - Measured Quantity Definitions 

harmonic components up to the 31th harmonic. 
 

1I  The current’s first harmonic component 

2I  The current’s second harmonic comp
compared to the first harmonic. 

 

Current and voltage 
RMS values for current and voltage are calculated as the root of the sum of squares for the 

(fundamental) specified as peak value. 
onent specified as peak value, has doubled frequency 

2
1

)...( 2
31

2
2

2
1 III

I RMS

++
=  

I  RMS Current in L1 (always positive). 
1IS  RMS Current in L1 with sign of power P1. 

I  System Current (always positive). 
IS  System Current with sign of power P1. 

3
321 IIII ++

=  

For voltage all definitions and formulas above are used. 

Power 

Harmonic component power 

The calculations below are for active power, the ca
that cos-functions are replaced with sin-function

lculations for reactive are identical except for 
s. 

 
1P  Active power in L1. 

n1  Active power in L1 is calculated for harmonic component n. 

nPA1  Power phase angle between harmonic component nU1  and nI1  
 
3-element method: 

)1cos(111 nnnn PAIUP ⋅⋅=  

∑
=

=
31

1
11

n
nPP  

 
2-element method: 
For 2-element method, only the total power is calculated in each harmonic component. 

nP  Total active power is calculated for harmonic component n. 

n1

P

ϕ  Phase angle between harmonic component nU12  and nI1  

n2ϕ  Phase angle between harmonic component nU32  and nI3  
 

)2cos(332)1cos(112 nnnnnnn IUIUP ϕ + ⋅ ϕ⋅⋅=  

∑
=

=
31

1n
nPP  
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Active and reactive power 

Active and reactive power is calculated as the sum of harmonic component power up to 31st 
inus signs, where negative power represents harmonic. The calculation is made with plus and m

export direction and positive represents import direction. 
 
P  Total active power 

1P  Active power in L1  
Q  Total reactive power 

1Q  Reactive power in L1 

 
321 PPPP ++=  
321 QQQQ ++=  

For 2-element meters, two elements are added instead of three. 

Apparent power 

S  Total apparent power 
1S  Apparent power in L1 

 
321 SSSS ++=  

RMSRMS IUS 111 ⋅=  

Demand of power 

T  Integration period in hours 
1P  Active power in L1  

1DP  Demand of P1 
1MDP  Maximum demand of P1 

 

∫= dttP
T 0

)(111  Average of P1 (with sign!). 

)1,1(1 MDPDPMAXMDP =  Max value of DP1 since reset / power on. 
 
The other phases and system is defined identically. This applies to reactive and apparent power as 
well. 
A simplified variant of demand is to measure the current only. To satisfy these needs there is a 
demand of current.  
 

1DI  Demand of I1 
DI  Demand of I system 

T

DP
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Energy 
Energy is calculated by integ
 

rating power (P, Q and S) over time. 

heading below. 

dra
dra

Quadra
uadra

port and export. The direction is controlled by the sign for active 
er 

ive 
ve 

drant is controlled by the sign for active 
and reactive power (e.g., active power >= 0 and reactive power >= 0 corresponding to quadrant I). 

Reactive energy import: quadrant I and II 
t III and IV 

re

ntrolled by the sign for 
p  ac ve energy has during the 

 quadrant I and IV 
gy export: quadrant II and III 

ower factor 

P=

n

eactive power factor 

tive power, the reactive power factor is negative. 

Definition of quadrants 
The term phase angle is described under its own 
 
Qua nt I: phase angle 0–90° 
Qua nt II: phase angle 90–180° 

nt III: phase angle -180–(-90)° 
nt IV: phase angle (-90)–0° Q

Active energy 

Active energy is calculated for im
pow (+ import, – export). 
 
Act energy import: quadrant I and IV 
Acti energy export: quadrant II and III 

Reactive energy 

Reactive energy is calculated for four quadrants. The qua

 

Reactive energy export: quadran
 
Reactive energy inductive: quadrant I and III 

eactive energy capacitive: quadrant II and IV R

Appa nt energy 

Apparent energy is calculated for import and export. The d tion i o
 ower; apparent energy is registered for the direction that the ti

irec s c
a
s
ctive
ame period. 

 
Apparent energy import:
Apparent ener

P

Active power factor 

S/  PF
 
With egative active power, the active power facto gativr is ne e. 

R

SQQF /=  
 
With negative reac
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Active power factor alternative definition 

( )PFQLF −⋅= 1sgn  

0,8

1

-1

-0,8

-0,6

-0,4

0

0,2

0,4

0,6

-180 -150 -120 -90 -60 -30 0 30 60 90 120 150 180

PhaseAngle (PA)

O
ut

pu
-0,2

t

PF
QF
LF

               Q4               Q2

               Q1                Q3

 

Phase angle values are between –180° and 180° (-π rad and π rad ). 

PA =
er phase angle, for an element is calculated from the fundamental phase angles.  

)fundPPA =  
 fro

ase angles on voltages and currents use PAU1, phase angle for voltage L1, as reference (0°). 
 and 

ad does not affect voltage phase angles, but PAI1, PAI2, PAI3 could be -20°, -
40°, 100°. With this example the power phase angle would be PA1 = 0 - (-20°) = 20°. 

Total harmonic distortion, THD, is a measure of the harmonic content in a signal.  
 

Phase angle 

Power phase angle 

11 PAIPAU −  1
Phase angle, or pow
 

/arctan( fund Q
Total phase angle is calculated m fundamental power. 

Phase angle voltage and current 

The ph
For unity power factor, the angles for PAU1, PAU2, PAU3 and PAI1, PAI2, PAI3 are 0°, -120°
120°. An inductive lo
1

THD 

%100
...

...
22

2
2

1

22
3

2
2 ⋅

++

++
=

n

n

III

III
THD  

Where 1I … nI  are the current’s harmonic components. The calculation is made in the same ways 
for current and voltage. 
THD values are 0 - 100%. 
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Appendix D – Material Declaration 

 

dripping, free of halogen 

Enclosure 
Polycarbonate (Macrolon)
 

lammability class: V-0 acc. to UL94, self-extinguishing, non-F
 
Connection terminals 
Terminals Steel 
Cage clamps Brass 
Screws Brass 
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Appendix E - Applicable standards and 

ent, control 

a ) Part 6-2: Immunity Table 1-4 
b)  Part 6-4: Emission Table 1 

IEC/EN 61000-4-3 Radiated RF-electromagnetic field immunity test 
 Electrical fast transient / burst immunity test 

Surge immunity test 

IEC/EN 61000-4-8 Power frequency magnetic field immunity test 
ptions/ variations immunity tests 

b) unity..limit..methods....apparatus 
unity..limit..methods...info. technology 

adio disturbance/immunity..limit..methods..industrial, 
nd medical equipment. 

 

regulations 
(industrial environments) 
IEC/EN 60688 Electrical measuring transducers for converting AC electrical quantities 

to analogue or digital signals 
IEC/EN 61010-1 Safety requirements for electrical equipment for measurem

and laboratory use. Part1: General requirements 
IEC/EN 60529 Degrees of protection provided by enclosures (IP code) 
IEC/EN 60068-1 Basic environmental testing procedures for electronic… 
IEC/EN 60068-2-1 Test A: Cold 
IEC/EN 60068-2-2 Test B: Dry heat 
IEC/EN 60068-2-3 Test Ca: Damp heat, steady state 
IEC/EN 60068-2-6 Test Fc : Vibration (sinusoidales) 
IEC/EN 60068-2-27 Test Ea : Shock 
IEC/EN 62053-31 Pulse output devices for electromech./ electronic meters (2-wire )    
IEC/EN 61326-1 a) c) Electrical equipment for measurement, control and laboratory use -

EMC requirements 
IEC/EN 61000-6-2, -6-4  Electromagnetic compatibility (EMC) 

Generic standards for industrial environments 
 

 

a) IEC/EN 61000-4-2  Electrostatic discharge immunity test 
a) 

a) IEC/EN 61000-4-4
a) IEC/EN 61000-4-5 
a) IEC/EN 61000-4-6 Immunity to conducted disturbances, induced by RF-fields 

) a

a) IEC/EN 61000-4-11 Voltage dips / interru
CISPR 16 Spec. for radio disturbance/imm

b) CISPR 22 Spec. for radio disturbance/imm
c) CISPR 11 Spec. for r

scientific a
EN50160 Power quality standard 
DIN 40 110 Quantities used in alternating current theory; two-line circuit 
DIN 43 807 Markings for switchboard, meters, measuring transducers 
UL 94 Plastic flammability standard (for parts in transducer devices)
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Appendix F – Approvals and certificates 
YADAV MEASUREMENTS PVT. LTD 
 
YMPL/147495/26987A 
YMPL/147496/26988A 
YMPL/159049/27420 
YMPL/159049/27421 
YMPL/159049/27422 
YMPL/159049/27423 
YMPL/162259/27457 
YMPL/173109/27783 
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Appendix G – Technical specification 

he current inputs are galvanically isolated from each other and to any other internal or external 
otential. 

he analog and digital outputs and communication ports are isolated from each other and to any 
l potential. 

cer cover. Always disconnect all wires carrying 
g the transducer. Note that all warranties will be obsolete if the 

ARNING: This is a class A product. In a domestic environment this product may cause 
radio interference in which case the user may be required to take adequate measures. 
 

Measurement generally 
Accuracy Class 0.2, Class 0.5 
Frequency 50/60 Hz (45-65 Hz) 
Measurment True RMS Up to 31st harmonic 
Measurement category CATIII ≤ 300VAC (versus 

earth),  CATII  ≤ 600VAC 
(versus earth) 

Voltage circuit 
Nominal measuring voltage (UN) 
3-wire system: 3x100-693 V 
4-wire system: 3x57,7/100-3x400/693 V 
Range: 0% – UN – 120% 
Input impedance: 400kΩ (per phase) 
Consumption: ≤U2/400kΩ ±3% (per ph) (W) 
Max overload voltage 1.2 x UN continuously 

1.5 x UN during 10 s with max. 
10 attempts with 10 s 
between 

2 x UN during 1 s with max. 
10 attempts with 10 s 
between. 

Starting voltage 0.25 V 
Connector screw terminals for ≤ 6 mm2

Current circuit 
Nom. measuring current (IN) 1-5 A 
Measuring range 0 - 200% of IN 
Consumption ≤ I² x 0.01Ω  (per phase) 
Max overload current 2 x IN continuously 

20 x IN during 1 s with max. 
10 attempts with 100 
s between 

40 x IN during 1 s with max. 
5 attempts with 300 s 
between. 

Starting current 4 mA 
Connector screw terminals for ≤ 6 mm2 

Auxiliary supply 
Voltage range  40-276 VAC/VDC 
AC frequency 45 – 65 Hz 
Max burden ≤ 12VA / 7W 
Inrush current < 35 A / 0.3 ms 

Analogue outputs 
Number of outputs 4 
Type current /voltage bi-polar  
Max voltage at open output: ≤ ±20V  
Max over-driven output ≤ ± 125% (hardware 

limiter) 
Load influence ≤ 0,1% 
Range/Load (current outp) ±20mA / ≤ 750Ω 
 ±5mA / ≤ 3kΩ 
 ±2mA / ≤ 7,5kΩ  
Range / Load (voltage outp) ±10V / ≥ 2kΩ 
 ±2V / ≥400Ω 
Residual ripple ≤ 0,4 % (peak to peak at 

full load) 
Auxiliary voltage influence  ≤ 0,1% 
Temperature coefficient ≤ 0,01% extra per deg C 
Programmable response 200 ms, 300 ms, 600 ms, 
time (t99) 900 ms, 1.2s, 1.5s, 2s, 5s, 
 10s, 30s 

Digital outputs 
Number of outputs 2 
Accuracy 0.5s 
Type Solid-state MosFET relay, 

bi-directional rating 0,2 
A, 110 VAC/DC (Varistor 
protected) 

Pulse length 10 ms - 1 s 
RON 8Ω (max) 

Safety 
T
potential. The voltage input group is galvanically isolated to any other internal or external p
T
other internal or externa
WARNING: Live parts inside transdu
dangerous voltages if openin
transducer has been opened. 
W
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Communication ports 

Serial RS485 port 
Connector Three screw terminals for 

≤ 6 mm2

d 

Serial USB port 
U

Com. protocol M
N
38

0…

Com. protocol Modbus RTU 
Baud rate 1200 - 38400 bau

Connector SB Mini-B connector 
odbus RTU 

Hand shaking ot supported 
Baud rate 400 baud (automatic) 

Temperature range 
Normal temperature 15….30….+45 °C 

 

Operating temperature 0 °C - +55 °C  -1
-4
0.
10
≤ 80

Altitude m

r

e- in
u d

r  to

II (Do
EN 61

ll 2 
Installatio  CATI

and au
300VA
CATI
inputs
earth) 

 housing IP40 (t
60529)  

 terminals IP20 (test finger, IEC/EN 
60529) 

Common mode voltage 600VRMS CATII 
 300VRMS CATIII 
 
 
 
 
 
 

Insulation surge test 5kV 1,2/50µs  0,5Ws  (valid 
rcuits with reference 

 ≥40V) 
r surface versus earth *) 

 • All voltage input versus 
earth*)

 • All current input versus 
earth*)

*)

ulation AC-voltage test acc. to EN61010-1 
*)

puts connected together 
th*)

 input versus earth*)

2,2kVAC/50Hz/1min • All voltage inputs versus 
earth*)

• All current inputs versus 
earth*)

• All digital outputs versus 
earth*)

us 

earth*)

• USB-COM.port versus 
earth.*)

ircuits/terminals not under test are connected to 

/-3 Temp/Humidty: Cold, dry, 

celeration ±2 g 
Frqv. range: 10…150…10Hz, 

equency 
te 

 

3 x 50 g, 
3 shocks each in 6 directions 

IEC/EN61000-6-2/-6-4 Electromagnetic compability 
 standards for 

ents, 
ission.  

Weight 
Weight 500 g

Storage temperature 0 °C - +85 °C 
t Temperature coefficien 5 x basic accuracy per 0,5kVAC/50Hz/1min: • All analog outputs vers

*)°C 
Relative humidity  % 

ax 2000 m 

earth
 • RS-485 COM.port versus 

Environment Indoor only  

Reference conditions  

*) ll cUsage group according to A
IEC/EN60688 g oup II earth 
Reference temperature 

e +15 °C - +30 °C Ambient tests rang
conditioning 30 m  

IEC/EN60068-2-1/-2
Pr
Inp t variable Rate  useful range 
Fo further information refer  EN60688 table 3 and 4. heat, damp 

IEC/EN60068-2-6 Vibration: Ac

Safety rate of fr
Prot

010-1 Table D.12  Number of cycles: 10, in each
ection class uble insulation)  sweep: 1 octave/minu

Po ution degree 
n category II (refer to measuring 

of the three axes 
IEC/EN60068-2-27 Shock: Acceleration 

xiliary inputs ≤ 
C versus earth) 

 I (refer to measuring (EMC). Generic
vironm  ≤ 600VAC versus industrial en

Protection est wire, IEC/EN 
immunity and em

for ci
voltage

 • Oute

 • Auxiliary input versus earth
Ins
3,7kVAC/50Hz/1min • Outer surface versus earth
 • All voltage- and current- 

in
versus ear

 • Auxiliary
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